
 

 

 

SESSION 2 
EAT RIGHT! 
In this session, students learn about a balanced diet. To help TechnoFit Club 

members make healthy food choices, students watch the video Eat Right. 

Afterwards, they create a Be Fit Food Guide, which contains pictures of food 

items organized under Food Group headings. This guide is a great way to help 

students make healthy food choices. 

 

Eat Right! 

 
Assignment 3: Eat Right to Be Healthy 

Assignment 4: My Be Fit Guide 

Session 2 Review: Food Groups 

Session 2 Skill Review: What is for Dinner? 

Session 2 Extension Activity: Food Servings 
  

TechnoFit introduces the 
concept of a healthy 
lifestyle.  
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Session 2: Eat Right! 

Getting Started 
 

Overview 

In this session, students learn about a balanced diet. To help TechnoFit Club members make 

healthy food choices, students watch the video Eat Right. Afterwards, they create a Be Fit Food 

Guide, which contains pictures of food items organized under Food Group headings. This guide is 

a great way to help students make healthy food choices. 

 

Eat Right! 

 

 

 

Materials 

 Publisher 2013 

 Eat Right video (requires Windows Media Player) 

 Guide sample file 

 Food Cards (Optional) 

 Microsoft Publisher Flashcards (Optional) 

o Publisher 2013 Home Tab 

o TechnoFit Quick Access Toolbar 

 Session 2 Review: Food Groups (Optional) 

 Session 2 Skill Review: What’s for Dinner (Optional) 

o Dinner sample file for Skill Review (Optional) 

 

 

Teacher Preparation 

 (Optional) Print the guide sample file 

 (Optional) Gather the flashcards for this session. 

 (Optional) Print the Food Cards located in the Session 2 teacher resource folder. Cut out 

each card. Sort each item on the cards into food groups. 

 

 

Teaching Strategy 

In this session, students learn about healthy eating. Explain scenario to students: 

 

As part of the Be Fit Challenge, you need to eat right. To help you learn 

about the importance of a balanced diet watch the Eat Right video. 

Then open Microsoft Publisher and create a “Be Fit Food Guide.” This 

guide will contain food items organized by their Food Group. It is sure to 

be a great help when you are trying to make healthy food choices. 

 

Each session provides a 
materials list, teacher 
preparation tips, and teaching 
strategies. 
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Assignment 3: Eat Right to Be Healthy 

 

In this assignment, students watch the Eat Right video to learn about the importance of a 

balanced diet. Afterwards, use the Food Cards to teach students about food groups. 

 

To help your students understand how to sort food into categories, TechnoFit resources include a 

set of 48 food cards. Use them to teach food groups. Sample food cards: 

 

        
apple carrot cheese milk bread cereal steak fish 

 

 

1. Write the food group names onto the board.  

2. Hold up a food card and have students identify the food group. 

3. Place the card under the correct heading. 

 

 

 
TEACHER TIP: Where you live, has a lot to do with what you eat. For this reason, the food guidelines are slightly different 

around the world. If you are an American educator, visit www.choosemyplate.gov. If you are an educator in another 

country, you can use the Internet to find your food guide. The search terms country name dietary guidelines will get you 

started. 

 

 

 

 

Assignment 4: My Be Fit Guide 

 

In this assignment, students create a Be Fit Guide. To start they create the Food Group headings 

using WordArt. Afterwards, pictures of healthy food items are organized under the correct 

heading. Students should be familiar with the Publisher commands as they were introduced in 

the previous session. 

 

You may wish to write the Food Group headings and some food words on the board to help 

students with the spelling. 

 

A grading scheme is available in Session 7 if you would like to assess the completed food guide. 

 
Activity Poor - 1 Fair - 2 Good - 3 Excellent -4 

Food Guide 

Sort food items 

into their Food 

Groups using 

pictures and 

WordArt. 

Items incorrectly sorted Some items correctly sorted All items correctly sorted, 3 items per 

group 

All items correctly sorted, 4 items per 

group 

Words are difficult to read Some words are difficult to read Most words are easy to read All words are easy to read 

Words not formatted Words formatted with only one option Words formatted with more than one 

tool 

Words formatted with many tool 

options 

Unbalanced layout Somewhat balanced layout Balanced layout Balanced and eye-catching layout 

Details about assignments 
suggest teaching tips. 

Assess student progress with 
the included grading scheme. Sam
ple
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Lesson Plan 

Assignment 3 - Eat Right to Be Healthy 

 Watch the Eat Right video. 

 Answer questions about the video. 

 Learn about food groups. 

 

Assignment 4 - My Be Fit Guide 

 Open Microsoft Publisher to a Blank 8.5 x 11" publication. 

 Use WordArt to add Food Group names. 

 Under each Food Group, insert pictures of food items from that group. 

 Save publication as guide. 

 Print the publication. 

 Close Publisher. 

 

The Lesson Plan provides the 
steps taken in each 
assignment. 
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Learning Objectives 

Below is a list of the learning objectives for this session. Students should be able to complete each 

task independently. 

 

Content Knowledge: 

 

 classify food into food groups 

 

 

Technical Skills: 

 

Operating Environment 

 

 open and close a program 

 save a publication 

 print a publication 

 

 Applied Technology 

 

 create a food guide using Microsoft Publisher  

 

 Desktop Publishing 

 

 add WordArt to a publication with an eye-catching design 

 draw a text box and add text into the object 

 format the font, size, style, color, and alignment of text to make the words stand 

out 

 search for and insert suitable pictures into a publication 

 position and resize objects in a publication to create a good layout 

 select a blank full page publication 

 

 

Learning Objectives are 
included with each Session. A 
complete summary of all 
objectives are available at the 
end of the guide. 
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Assignment 3: Eat Right to Be Healthy 
 

All TechnoFit Club members must eat right. To learn more about  

healthy eating watch the "Eat Right" video and then answer the  

questions. 

 

 

Watch the Eat Right Video 

 Double click the shortcut to the Fit folder or ask your teacher  

how to get to the folder. 

 

 Double click Eat Right. 

 Watch, listen, and learn! 

 

 

 

About the Eat Right Video 

1. List three healthy foods: 

  

    

  

  

    

  

  

    

 

 

  

Included videos introduce 
students to the task and 
initiate discussion. 
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2. What group is each food item from? 

 

  

 apple  

  

 bun  

  

 fish  

  

 cheese  

 

 
TEACHER TIP: FOOD GROUPS 

 

Sample food cards: 

 

        
apple carrot cheese milk bread cereal steak fish 

 

 

1. Write the food group names onto the board.  

2. Hold up a food card and have students identify the food group. 

3. Place the card under the correct heading. 

 

 

 

 
TEACHER TIP: DIETARY GUIDELINES ARE NOT UNIVERSAL 

 

Where you live, has a lot to do with what you eat. For this reason, the food guides are slightly different around the world. 

If you are an American educator, you should visit www.choosemyplate.gov. If you are an educator in another country, 

you can use the Internet to find your food guide. The search terms country name dietary guidelines will get you started. 

To have a balanced diet, you need to eat 

different foods. Food can be sorted into groups. 

You need to eat food from each Food Group to 

stay healthy.  

 

Ask your teacher about "Food Groups". Then 

answer the question below. 

TechnoFit resources include a 
set of 48 food cards. Use 
them to teach food groups. Sam
ple
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Assignment 4: My Be Fit Guide 
 

 

Open the Full Page Template 

 Open Publisher.  

 In the FEATURED area, click Blank 8.5 x 11". 

 

 Publisher creates the new blank document. 

  
 

 

  

As part of the Be Fit Challenge you 

need to eat right!  

 

Create your own Be Fit Food Guide to 

help you to make healthy choices. 

Blank 8.5 x 11" 

TIP: If you want to see the whole page in the window:  

 

 Click Show Whole Page in the bottom corner. 

or 

 Drag the Zoom Slider to the left. 
Show Whole Page 

Step-by-step instructions 
include illustrations. 
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Add the Title "Be Fit Guide" using a Text Box 

 On the Quick Access toolbar, click Draw a Text Box. 

 Click and drag to draw a text box between the blue margin guides. 

 

 Type the title Student Name's Be Fit Guide. 

 Triple click the mouse inside the text box to select the title. 

 

Make the Words Look Good 

 Find the Font group on the Home tab. 

 Click Font Color to change the color of the title. 

 

 Click on a color in the palette. 

 

 Use your skills to change the way the words look using these Font group commands. 

 Change the font of the letters. 

 Change the size of the letters. 

 
Add a bold style to make the letters darker. 

 
Slant the letters to the right. 

 
Place a line below the letters. 

TIP: Instead of using the 

Home tab, you can also use 

the Mini Toolbar. Notice that 

when you triple click to 

select the words, the Mini 

Toolbar appears. It has 

many of the tools you need 

to make the text look great. 

Alex’s Be Fit Guide 

Helpful tips and screenshots 
are included. 
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Center the Title 

 Find the Paragraph group on the Home tab. 

 
 

 Click Center to put the title in the middle of the text box.  

 

Add Food Group Names using WordArt 

 Click Insert WordArt on the Quick Access toolbar. 

 Pick a WordArt style from the gallery. 

 

 In the Edit WordArt Text dialog box, type a name of a Food Group.  

 

 

 Click OK. 

 Use your skills to move, size, and rotate the WordArt. 

Ask your teacher to 

write the Food Group 

names on the board. 

Easy to follow instructions 
can foster working 
independently. 
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 Add the other Food Groups using WordArt. 

 
 

 

 
 

 

 

 

 

Add Pictures of Food Items 

 On the Quick Access toolbar, click Online Pictures. 

 In the Office.com Clip Art box, type a food item. Click Search. 

 

  

apple cereal carrot steak cheese 

banana rice pepper chicken milk 

orange bread lettuce egg ice cream 

TIP: If you made a mistake with the WordArt you can fix it.  

1. Click on the WordArt.  

2. Click the WordArt Tools Format tab.  

3. Click Edit Text to change the letters.  

Or from the WordArt Styles group, pick another style from the gallery. 

grapes 

Here are some words that might help: 
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 Look at the results. When you see one that you like, click on it. Click Insert. 

 
 

 Resize it. Move the picture under the correct Food Group name. 

 Keep adding pictures of food. Place two or three food items in each Food Group. 

 

 

Complete the Poster 

 Apply what you know to complete the poster.  

  
 

 

Save the Food Guide 

 Click Save on the Quick Access Toolbar.  

 Go to the place where you save your work. 

 Name the file guide. 

 Click Save. 

  

Tips: 

 

 Make sure the Food Group 

names are easy to read. 

 Put the Food Groups at 

different places on the page. 

 Use colorful pictures. 

 Use the whole page BUT stay in 

the boundaries or your work 

might not print. 

TIP: You may need to 

scroll down to find a 

picture you like. 

Completed sample files 
provide inspiration and clarity 
for students. 
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Print the Food Guide 

 Click the File tab and click on Print. 

 Click the Print button. 

 
 

 

 

Close Publisher 

 Click the Close button in the top right corner of the program window. 
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Session 2 Review: Food Groups 
 

Circle the food that does not belong in the Food Group? 

 

 

1. 

 
 

 
  

  

  

  

2. 

 
 

 

  

  

  

  

3. 

 
  

  

  

  

  

4. 

 
 

 

  

  

  

  

5. 

 
  

  

 

Review activities cover 
technology skills and content 
knowledge. 
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Session 2 Skill Review: What is for Dinner? 
 

To eat right you need to eat food from every Food Group. Plan a dinner that includes food from 

all the Food Groups.  

 

  

1. Open Microsoft Publisher.  
  

2. In the FEATURED area, click Blank 8.5 x 11”. 

  

3. Add My Dinner using WordArt. 
 

  

4. Add pictures of the food you will eat for dinner. 
 

 Find at least one picture from each food group. 

  

5. Save the publication in your student folder as dinner. 

  

6.  Print your work and give it to your teacher. 

  

7.  Close Publisher. 

 

 
 

 

 

 

  

Comprehension is assessed 
with Skill Reviews. 
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